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Overview
What is the Siemens TCP/IP Slave Ethernet Driver?

Channel Setup
How do I configure a channel?

Device Setup
How do I configure a device for use with this driver?

Configuring Connections Using the SIMATIC Manager
How do I configure connections using the SIMATIC Manager?

Data Types Description
What data types does this driver support?

Address Descriptions
How do I address a data location on a Siemens TCP/IP Slave Ethernet device?

Error Descriptions
What error messages does the Siemens TCP/IP Slave Ethernet Driver produce?

Overview
The Siemens TCP/IP Slave Ethernet Driver provides an easy and reliable way to connect Siemens TCP/IP Slave Eth-
ernet devices to OPC Client applications, including HMI, SCADA, Historian, MES, ERP and countless custom appli-
cations. This driver will act as a simulated Siemens PLC. It is intended for simulation of Siemens S7-300.

See Also: Master Device Configuration
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Channel Setup
Communications Parameters

Description of the parameter is as follows:

l Port Number: This parameter specifies the port number on which the driver will listen. Devices must be
configured to connect to this port: messages sent to all other ports will be ignored by the driver. The valid
range is 0 to 65535. The default setting is IE TCP/IP: 102 (TSAP).

Note: Non-standard values may be necessary due to routing and firewall issues.
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Device Setup
Supported Protocols
S7 Messaging on Industrial Ethernet (ISO 8073 Class 0) over TCP/IP. This is defined in RFC1006.

Supported PLC
S7-300

Supported Commands
SFB14-GET
SFB15-PUT

Maximum Number of Supported Channels and Devices
The Siemens TCP/IP Slave Ethernet Driver supports one channel and 256 virtual devices.

Libraries
This driver requires a standard Ethernet card. No special libraries or hardware are needed.

Note: In order to communicate with this driver, devices require specialized ladder programming.

Cable Diagrams

CPU Settings
The CPU Settings dialog is used to specify the rack and slot values that will be associated with the device.
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Descriptions of the parameters are as follows:

l Rack: This parameter specifies the number of the rack in which the simulated CPU of interest resides.
The valid range is 0 to 7. The default setting is 0.

l CPU Slot: This parameter specifies the number of the slot in which the simulated CPU of interest resides.
The valid range is 0 to 31. The default setting is 0.

Note: Devices must have unique rack/slot values.

Master Device Configuration
Siemens PLCs must be programmed to issue read and write commands to the driver and to handle returned data.
For more information, refer to the Siemens PLC programming documentation. For information on preparing the
Master Device and the unsolicited driver for communications, refer to Configuring Connections Using the
SIMATIC Manager.

Messages must be sent to the IP address of the selected Ethernet adapter of the host computer running the
unsolicited driver. To do so, click Channel Properties | Network Interface. For more information concerning
the port number configured for the simulated device, refer to Channel Setup.
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Configuring Connections Using the SIMATIC Manager
Connections are configured using the SIMATIC Manager software. The following topics provide information on
configuring the Siemens TCP/IP Slave Ethernet Driver to run in unsolicited mode, and demonstrate a basic setup
using the S7-300 PLC as the active partner and the Siemens TCP/IP Slave Ethernet Driver as the passive partner.

Note: The Siemens TCP/IP Slave Ethernet Driver can configure 256 devices, each with an associated slot/rack.
When the active partner (master) communicates with the passive partner (unsolicited driver), it directs its
requests to a specific device in the unsolicited driver. Multiple remote partners can talk to the same device.

To jump to a specific section, select a link from the list below.

Step One: Creating a New Project
Step Two: Configuring the Master and PC Station
Step Three: Connecting the Master and the Slave Driver
Step Four: Inserting Function Blocks
Step Five: Creating the DB3 Data Block
Step Six: Inserting PUT FB
Step Seven: Downloading to the PLC

Step One: Creating a New Project

1. To start, open the SIMATIC Manager software and then create a new project. In this example, the project
being used is "Setup".

Note: The project's main window should appear as shown below.
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2. Next, create the Master and PC Station. To do so, right-click in the right pane of the window and then
select Insert New Object | SIMATIC 300 Station.

Note: The Master unit is the active partner or the image of the actual PC. The PC Station is the PC on which
the SIMATIC Manager software is running.

Note: The SIMATIC 300 station should appear as shown below.
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3. Name the new station "MASTER," because it represents the communication's active partner.

4. Next, right-click in the right pane of the window and then select Insert New Object | SIMATIC PC Sta-
tion.
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Note: The SIMATIC PC Station should appear as shown below.

Note: For more information, refer to Step Two: Configuring the Master and PC Station.

Step Two: Configuring the Master and PC Station
Industrial Ethernet (IE) is the protocol used for communication.

1. To start, right-click in the right pane of the SIMATIC Manager window. Then, select Insert New Object |
Industrial Ethernet.
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Note: The main window should now display an Ethernet icon.

2. Next, select the MASTER icon in the left pane of the window. Then, double-click on Hardware.
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Note: The HW Config window should appear as shown below.

3. Next, open the View tab and select Catalog. Then, expand the SIMATIC 300 menu and the Rack 300
menu.
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4. To insert the racks, double-click on Rail.

5. Next, expand the PS 300 menu. Double-click on PS 307 10A or any other suitable option to insert the
power supply into slot 1.
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6. To insert the CPU, expand both the CPU 300 menu and the CPU 315-2 DP menu. Then, double-click on
the CPU that matches the hardware.
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7. To insert the CPU into slot 2, clickOK.

8. To insert the CP, leave slot 3 empty and then click on slot 4 in the racks.

9. Next, expand both the CP 300 menu and the Industrial Ethernet menu. Then, double-click on the CP
that matches the hardware.
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Note: The window should appear as shown below.
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10. Next, enter the PLC's IP address and subnet mask. Then, select Ethernet from the subnet box.

11. Click OK to configure the Master.
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Note: Once finished, open the View tab and then select Catalog to hide the catalog window.

12. Save and exit the HW Configuration window.

13. To configure the PC station, click on the SIMATIC PC Station in the left pane of the SIMATIC Manager win-
dow. Then, double-click on Configuration.
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14. Next, click on the View tab and select Catalog.

15. Expand both the SIMATIC PC Station menu and the CP Industrial Ethernet menu. Then, double-
click on IE General or any other suitable option.
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Note: The window should appear as shown below.
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16. Enter the IP address of the PC running the SIMATIC Manager software, in addition to the correct subnet
mask.

17. Next, select Ethernet from the subnet box. Then, clickOK to configure the PC station.
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Note: Once finished, open the View tab and then select Catalog to hide the catalog window.

18. Save and exit the HW Configuration window.

Note: For more information, refer to Step Three: Connecting the Master and the Slave Driver.

Step Three: Connecting the Master and the Slave Driver
Once the Master and the PC Station have been successfully configured, the Master and the Slave Driver must be
connected.

1. To start, open theOptions tab in the SIMATIC Manager window and then select Configure Network.
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2. Next, click on the Master's CPU 315-2 DP block. A series of rows should be displayed in the lower half of
the window.
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3. Right-click on the first row and select Insert New Connection.

4. Then, clickOK.

Note: The window should appear as shown below.
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5. Next, enter the IP address of the machine on which the Siemens TCP/IP Slave Ethernet Driver will be run-
ning.
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6. Next, click Address Details and enter the rack/slot values of the device in the unsolicited driver with
which the Master will be communicating.

7. Once finished, clickOK twice to successfully connect the master and slave drivers. The master will use
these settings to communicate with the destination device at rack 0 and slot 2.
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Note: The Local ID number (=1) identifies the connection between the two partners. This number will be
used later when creating function blocks for reading and writing data.

8. To finish, save and compile the data by opening the Network tab and selecting Save and Compile.
Then, clickOK.

Note: There should be no errors on compilation.

Note: For more information, refer to Step Four: Inserting Function Blocks.

Step Four: Inserting Function Blocks
Once the master has been configured and connected with the unsolicited driver, it must also be prepared to gen-
erate requests for the unsolicited partner. This is done by creating function blocks, which can be used to read
data from or write data to an unsolicited driver. The function block (FB) used for reading data in this example is
FB14 (GET). The function block (FB) for writing data is FB15 (PUT).
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1. To start, expand the Master menu, the CPU 315-2 DP menu, and the S7 Program[1] menu.

2. Next, double-click on Blocks and OB1.

3. LAD, STL, or FBD can be used to create function blocks. In this example, FBD is used. In the LAD/STL/FBD
window, click on the Insert menu.
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4. Then, click Program Elements.

5. Next, expand the Libraries, SIMATIC_NET_CP, and CP 300 menu. Then, double-click on FB14 GET
to insert a function block to read data.
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6. Close the Program Elements window. "FB14" should be inserted as shown below.

7. Next, associate a data block (DB) with the function block (FB). To do so, click above the FB where there
are three red question marks.

www. kepware.com

33



Siemens TCP/IP Slave Ethernet Driver Help

8. Enter the name of a data block. In this example, it is "DB2".
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9. Next, click Yes to create the data block.

10. Next, fill in the other details as appropriate for the fields in the function block. Users should consider the
following:

l "ADDR_1" is the address on the destination device in the unsolicited driver.

l "RD_1" is the address local to the PLC.

l The value at the remote address specified by "ADDR_1" is written (GET) to the local address
specified by "RD_1".

l Enter the Local ID number that was generated when setting up the connection between the
Master and the Slave Driver in the ID field. In this example, the Local ID number is 1.

Important: The number of bytes in both the "ADDR_1" and "SD_1" fields should be same in
order for the unsolicited driver to respond correctly. Otherwise, an error message will be sent.
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Note: Now that the GET function block has been created successfully, users must remember that the
block gets executed/triggered only on a rising edge (REQ).
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11. To finish, click Save and then close the LAD/STL/FBD window.

Note: For more information, refer to Step Five: Creating the DB3 Data Block.

Step Five: Creating the DB3 Data Block
While configuring GET FB, the data block "DB3" was used for the "RD_1" field. This is the data block that will
store read values.

1. To start, right-click in the right pane of the SIMATIC Manager window and then select Insert New
Object| Data Block.
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2. Next, change the name to "DB3."
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Note: The window should appear as shown below.

3. Next, double-click on DB3. In order to assign somememory to the data block, users can make changes
similar to those shown in the window below. Although the array size in this example was chosen arbi-
trarily, values should be specified to fit a particular need.
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4. Once finished, save and close the LAD/STL/FBD window.

Note: For more information, refer to Step Six: Inserting PUT FB.

Step Six: Inserting PUT FB

1. Next, create a separate data block for the PUT FB, which holds the data that is written to the remote part-
ner. To insert this new data block, follow the steps in Step Five: Creating the DB3 Data Block but
name it "DB5."

2. Double-click on DB5, and then specify a memory size. Although the array size in this example was chosen
arbitrarily, the values should be specified to fit a particular need.
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3. To insert the PUT FB, double-click on OB1 in the SIMATIC Manager window. In LAD/STL/FBD, right-
click in the blank space below GET FB.
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4. Next, click Insert Network and then select the blank space below.

5. Next, click Insert | Program Elements. Then, expand the Libraries, SIMATIC_NET_CP, and CP 300
menus.
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6. To insert a function block to write data, double-click on FB15 PUT. Then, close the Program Elements
window.

7. Next, associate a data block (DB) with the function block (FB). To do so, click above the FB where there
are three red question marks. Then, specify a name. In this example, "DB4" is used.

Note: A window prompt will ask for confirmation of data block creation. Click Yes.

8. Fill in the other details as appropriate. Users should consider the following:

l "ADDR_1" address is on the destination device in the unsolicited driver.

l "SD_1" is the address local to the PLC.
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l The value at the local address specified by"SD_1" is written (PUT) to the remote address spec-
ified by "ADDR_1".

l Enter the Local ID number that was generated when setting up the connection between the
Master and the Slave Driver in the ID field. In this example, the Local ID number is 1.

Important: The number of bytes in both the "ADDR_1" and"SD_1" fields should be same in
order for the unsolicited driver to respond correctly. Otherwise, an error message will be sent.
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9. To finish, click Save and then close LAD/STL/FBD.

Note: For more information, refer to Step Seven: Downloading to the PLC.

Step Seven: Downloading to the PLC
Once the Master has been prepared to generate Read/Write requests for the remote unsolicited partner, the infor-
mation must be downloaded to the PLC.

1. To start, clickMaster in the left pane of the SIMATIC Manager window. Then, select the PLC menu.

2. Next, select Download to begin downloading the project to the PLC.
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3. ClickOK.

4. Then, click Yes.

Note: The master must be run in order to trigger the function blocks that generate Read/Write requests.

5. Double-click on OB1 in the SIMATIC Manager window.

6. In LAD/STL/FBD, click Debug | Monitor.
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Note: LAD/STL/FBD should appear in Online Mode as shown below.
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7. To execute GET/PUT FBs, change the REQ value to 0 and then 1 to indicate the rising edge. To do so,
right-click on the REQ field and selectModify to 0 to force a zero to the field.
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8. Next, right-click on the REQ field and selectModify to 1 to force a value of one to the field.
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Note: Both of the FBs must next be configured to respond to the same rising edge in order for the
SIMATIC Manager's variables to be locally monitored and modified.

9. In LAD/STL/FBD, click on PLC and then selectMonitor/Modify Variables.

10. Enter the variables that will be monitored. To view the changes made to this window, execute the function
blocks.
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Note: Remember that the slot/rack value of the remote device with which the master is communicating is
"rack:0 slot:2". The values can be changed from the NetPro window. Users must make sure that the
unsolicited driver on the other end has a device with these values and is running.
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Data Types Description

Data Type Description
Boolean Single bit
Byte Unsigned 8 bit value
Char Signed 8 bit value
Word Unsigned 16 bit value

bit 0 is the low bit
bit 15 is the high bit

Short Signed 16 bit value

bit 0 is the low bit
bit 14 is the high bit
bit 15 is the sign bit

DWord Unsigned 32 bit value

bit 0 is the low bit
bit 31 is the high bit

Long Signed 32 bit value

bit 0 is the low bit
bit 30 is the high bit
bit 31 is the sign bit

BCD Two byte packed BCD

Value range is 0-9999. Behavior is undefined for values beyond this
range.

LBCD Four byte packed BCD

Value range is 0-99999999. Behavior is undefined for values beyond
this range.

Float 32 bit floating point value.

The driver interprets two consecutive registers as a floating point
value by making the second register the high word and the first reg-
ister the low word.

String NULL Terminated ASCII String
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S7-300 Address Descriptions
The default data types for dynamically defined tags are shown in bold.

Address Type Range Type Access
Discrete Inputs I0.b-I4095.b*

.b is Bit Number 0-7

IB0-IB4095

IW0-IW4094

IW:KT0-IW:KT4094

IW:KC0-IW:KC4094

ID0-ID4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write
Discrete Inputs

Note: I and E access the samememory area.

E0.b-E4095.b*
.b is Bit Number 0-7

EB0-EB4095**

EW0-EW4094

EW:KT0-EW:KT4094

EW:KC0-EW:KC4094

ED0-ED4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write
Discrete Outputs Q0.b-Q4095.b*

.b is Bit Number 0-7

QB0-QB4095

QW0-QW4094

QW:KT0-QW:KT4094

QW:KC0-QW:KC4094

QD0-QD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write
Discrete Outputs

Note: Q and A access the samememory area.

A0.b- A4095.b*
.b is Bit Number 0-7

AB0-AB4095

AW0-AW4094

AW:KT0-AW:KT4094

AW:KC0-AW:KC4094

AD0-AD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write
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Internal Memory  F0.b-F4095.b*
.b is Bit Number 0-7

FB0-FB4095

FW0-FW4094

FW:KT0-FW:KT4094

FW:KC0-FW:KC4094

FD0-FD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write
Internal Memory

Note: F and M access the samememory area.

M0.b-M4095.b*
.b is Bit Number 0-7

MB0-MB4095

MW0-MW4094

MW:KT0-MW:KT4094

MW:KC0-MW:KC4094

MD0- MD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write

Read/Write
Data Block Boolean DB1-N:KM0.b-KM4094.b*

1-N is Block Number
.b is Bit Number 0-15

Alternates

DB1DBX0.b-DBNDBX4094.b*
1-N is Block Number
.b is Bit Number 0-15

DB1D0.b-DBND4094.b*
1-N is Block Number
.b is Bit Number 0-15

Boolean

Boolean

Boolean

Read/Write

Read/Write

Read/Write

Data Block Left Byte DB1-N:KL0-KL4095
1-N is Block Number

Alternates

DB1DBB0-DBNDBB4095
1-N is Block Number

DB1DL0-DBNDL4095
1-N is Block Number

Byte, Char, String**

Byte, Char, String**

Byte, Char, String**

Read/Write

Read/Write

Read/Write

Data Block Right Byte DB1-N:KR0-KR4094
1-N is Block Number

Alternates

DB1DR0-DBNDR4094
1-N is Block Number

Byte, Char, String**

Byte, Char, String**

Read/Write

Read/Write

Data Block Unsigned Word DB1-N:KH0-KH4094
1-N is Block Number

Word, Short, BCD Read/Write

Data Block Signed Word DB1-N:KF0-KF4094
1-N is Block Number

Alternates

DB1DBW0-DBNDBW4094
1-N is Block Number

Word, Short, BCD

Word, Short, BCD

Read/Write

Read/Write
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DB1DW0-DBNDW4094
1-N is Block Number

Word, Short, BCD Read/Write

Data Block Signed Long DB1-N:KD0-KD4092
1-N is Block Number

Alternates

DB1DBD0-DB1DBD4092
1-N is Block Number

DB1DD0-DB1DD4092
1-N is Block Number

DWord, Long, LBCD, Float

DWord, Long, LBCD, Float

DWord, Long, LBCD, Float

Read/Write

Read/Write

Read/Write

Data Block Float DB1-N:KG0-KG4092
1-N is Block Number

Float Read/Write

Data Block BCD DB1-N:BCD0-BCD4094
1-N is Block Number

Word, Short Read/Write

Data Block S5 Timer as DB DB1-N:KT0-KT4094
1-N is Block Number

DWord, Long Read/Write

Data Block S5 Counter as DB DB1-N:KC0-KC4094
1-N is Block Number

Word, Short Read/Write

Data Block String DB1:S0.n-DB1:S4095.n*
.n is string length.
0<n<=218.

String Read/Write

*These memory types/subtypes do not support arrays.
**Byte memory types (MB) support strings. The syntax for strings is <address>.<length> where
0<length<=218.

Note 1: All offsets for memory types I, Q, and F represent a byte starting location within the specified memory
type.

Note 2: Use caution when modifying Word, Short, DWord, and Long types. For I, Q and F, each address starts at
a byte offset within the device. Therefore, Words FW0 and FW1 overlap at byte 1. Writing to FW0 will also modify
the value held in FW1. Similarly, DWord, and Long types can also overlap. It is recommended that these memory
types be used so that overlapping does not occur. For example, when using DWords, FD0, FD4, FD8 and so on
should be used in order to prevent overlapping bytes.

Arrays
All memory types/subtypes support arrays (excepting those discussed above). The valid syntax for declaring an
array is described below. If no rows are specified, row count of 1 is assumed.

<address>[rows][cols]
<address>.rows.cols
<address>,rows,cols
<address>_rows_cols

For Word, Short, BCD and "KT" arrays, the base address+(rows*cols*2) cannot exceed 4096. The elements of
the array are words, and are located on a word boundary. For example, IW0[4] would return IW0, IW2, IW4 and
IW6. "KT" subtypes fall into the 16-bit category because the data stored in the PLC is contained within a Word.

For Float, DWord, Long and Long BCD arrays (excluding "KT" subtypes), the base address+(rows*cols*4) can-
not exceed 4096. Keep in mind that the elements of the array are DWords, located on a DWord boundary. For
example, ID0[4] will return ID0, ID4, ID8 and ID12.

For all arrays, the total number of bytes being requested cannot exceed the internal block size of 218 bytes.

KL vs. KR vs. DBB
KL and KR determine whether the left byte or right byte of the data block word is returned.

Value 8 9 A B C
Byte 0 1 2 3 4

Example 1
DB1:KH0=0x89
DB1:KL0=0x8
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DB1:KR0=0x9
DB1DBB0=0x8

Example 2
DB1:KH1=0x9A
DB1:KL1=0x9
DB1:KR1=0xA
DB1DBB1=0x9

Examples
1. To access bit 3 of Internal Memory F20, declare an address as follows:
F20.3

2. To access Data Block 5 as word memory at byte 30, declare an address as follows:
DB5:KH30

3. To access Data Block 2 byte 20 and bit 7, declare an address as follows:
DB2:KM20.7

4. To access Data Block 1 as left byte memory at byte 10, declare an address as follows:
DB1:KL10

5. To access Internal Memory F20 as a DWord, declare an address as follows:
FD20

6. To access Input Memory I10 as a Word, declare an address as follows:
IW10
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Error Descriptions
The following error/warning messages may be generated. Click on the link for a description of the message.

Address Validation
Address '<address>' is out of range for the specified device or register
Array size is out of range for address '<address>'
Array support is not available for the specified address: '<address>'
Data Type '<type>' is not valid for device address '<address>'
Device address '<address>' contains a syntax error
Device address '<address>' is Read Only
Missing address

Driver Error Messages
Failure to start unsolicited communications on Port n
Winsock initialization failed (OS Error = n)
Winsock V1.1 or higher must be installed to use the Siemens TCP/IP Slave Ethernet device driver

Address Validation
The following error/warning messages may be generated. Click on the link for a description of the message.

Address Validation
Address '<address>' is out of range for the specified device or register
Array size is out of range for address '<address>'
Array support is not available for the specified address: '<address>'
Data Type '<type>' is not valid for device address '<address>'
Device address '<address>' contains a syntax error
Device address '<address>' is Read Only
Missing address

Address '<address>' is out of range for the specified device or register
Error Type:
Warning

Possible Cause:
A tag address that has been specified dynamically references a location that is beyond the range of supported
locations for the device.

Solution:
Verify that the address is correct; if it is not, re-enter it in the client application.

Array size is out of range for address '<address>'
Error Type:
Warning

Possible Cause:
A tag address that has been specified dynamically is requesting an array size that is too large for the address
type or block size of the driver.

Solution:
Re-enter the address in the client application to specify a smaller value for the array or a different starting point.

Array Support is not available for the specified address: '<address>'
Error Type:
Warning

Possible Cause:
A tag address that has been specified dynamically contains an array reference for an address type that doesn't
support arrays.
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Solution:
Re-enter the address in the client application to remove the array reference or correct the address type.

Data Type '<type>' is not valid for device address '<address>'
Error Type:
Warning

Possible Cause:
A tag address that has been specified dynamically has been assigned an invalid data type.

Solution:
Modify the requested data type in the client application.

Device address '<address>' contains a syntax error
Error Type:
Warning

Possible Cause:
A tag address that has been specified dynamically contains one or more invalid characters.

Solution:
Re-enter the address in the client application.

Device address '<address>' is Read Only
Error Type:
Warning

Possible Cause:
A tag address that has been specified dynamically has a requested access mode that is not compatible with what
the device supports for that address.

Solution:
Change the access mode in the client application.

Missing address
Error Type:
Warning

Possible Cause:
A tag address that has been specified dynamically has no length.

Solution:
Re-enter the address in the client application.

Driver Error Messages
The following error/warning messages may be generated. Click on the link for a description of the message.

Driver Error Messages
Failure to start unsolicited communications on Port n
Winsock initialization failed (OS Error = n)
Winsock V1.1 or higher must be installed to use the Siemens TCP/IP Slave Ethernet Driver

Failure to start unsolicited communications on Port n
Error Type:
Fatal

Possible Cause:
The driver was not able to create a listen socket for unsolicited communications. This is most often due to another
application using the port specified. Much less likely causes are related to low system resources.
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Solution:
Use network monitor software to check if any other application is using the port. If so, shut down the conflicting
application and restart the OPC Server. In many cases, the conflicting application is free to pick any available
port. If this is the case, make sure the server is always started first so that it may claim the required port. If both
the PLC programming software and this driver use the same port, they may not be able to be used simul-
taneously.

See Also:
Channel Setup

Winsock initialization failed (OS Error=n)
Error Type:
Fatal

OS Error Indication Possible Solution
10091 Indicates that the underlying network subsystem is

not ready for network communication.
Wait a few seconds and restart the driver.

10067 Limit on the number of tasks supported by the Win-
dows Sockets implementation has been reached.

Close one or more applications that may be
using Winsock and restart the driver.

Winsock V1.1 or higher must be installed to use the Siemens TCP/IP Slave Eth-
ernet device driver
Error Type:
Fatal

Possible Cause:
The version number of the Winsock DLL found on the system is less than 1.1.

Solution:
Upgrade Winsock to version 1.1 or higher.
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